Austin Peay State University, Tennessee Summer 2019
APSU Coding Camp # A: HTML / CSS / JavaScript (Optional)

APSU Coding Camp #A : Assignment 4

Total estimated time for this assignment: 7 hours

When you see “Richard Ricardo” in the example screen captures, change it to <your name>.

When you see “Richard” in the example screen captures, change it to <your first name>.

If you do not put <your name> / <your first name> in the above mentioned fields, you will get 0 points for
the question(s).

No two students should submit webpages with exactly the same code, or same content, or same layout, or
same color combination. If found, both students will get 0 points.

Create a folder on your hard disk, name the folder lastname_firstname_assignment4. Save all the files from
this assignment in this folder.

Create the following subfolders (in the folder lastname_firstname assignment4): q1, q2, q3.

As a result, you should have the following folder (directory) structure for this assignment: (-2 points if wrong)
e lastname firstname assignment4\ql\
e lastname firstname assignment4\q2\
e lastname firstname assignment4\q3\

Use Firefox Web Console (Tools > Web Developer > Web Console) to help debugging JavaScript. All html
(JavaScript) files must pass JavaScript validation at Firefox Web Console without any error, without any
warning (-2 points for each error, each warning).

e  Turn on your Firefox Menu Bar (Hint: right-click).

e Make sure your Firefox is up to date (Help > About Firefox).

e Turn on Web Console when you code (Tools > Web Developer > Web Console).

e Fix any error/warning immediately when you see them. Do NOT accumulate errors.

When you view page source in a web browser, <!DOCTYPE html> must be at the top of every page. In
other words, all pages must be written in HTMLS5. (-20 points if not)

>
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Question 1 — JavaScript Chapter 3 (30 points) Estimated time: 2 hours
e Save question 1 files in subfolder “lastname_firstname_assignment4\q1\”. (-25 points if no JavaScript)
e Create a web page that displays the default information (example shown). (1 point each, total 5 points)
e The initial page and related outputs should look like the examples shown below.
e Create your page using “<your name>’s Kung Fu Panda Po Power Level” as the page title. Save the page
as index.htm. Document the html file with html and JavaScript comments. (1 point each, total 3 points)

e Prompt the user to enter a number representing Kung Fu Panda Po's power level. (3 points)
e The power level conversions are as follows: (10 points for logic, 5 points for output format)

o less than 0: Po eats too much noodle

o 0to 20: Po reaches the training hall

o 21 to 40: Po reaches the student barracks

o 41 to 60: Po reaches the Peach Tree of Heavenly Wisdom

o 61 to 80: Po climbs the Wu Da Mountains

o 81to 100: Po trains at the Pool of Sacred Tears

o  Greater than 100: Po defeats Tai Lung
e Create a css file named style.css to format index.htm by creating your own layout (no two students should

have the same layout). Use css comments to document the css program. You can use the same (or similar)
css file(s) to format all questions. (1 point each, total 2 points)

Example: Initial Page

Richard Ricardo’'s Kung Fu Panda

h Power Level

This page will prompt Richard Ricardo for Kung Fu Panda Po's power level (in number). The
program will convert the given input into Po's power metric.

less than 0: Po eats too much noodle

0 to 20: Po reaches the training hall

21 to 40: Po hes the student barracks

41 to 60: Po reaches the Peach Tree of Heavenly Wisdom
61 to 80: Po climbs the Wu Da Mountains

81 to 100: Po trains at the Pool of Sacred Tears

Greater than 100: Po defeats Tai Lung

Click on the button below to enter Po's power level.

Po's Power:
Po’'s current power level
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Example: Input qla

Enter po's power level

Example: Output qla

Richard Ricardo’'s Kung Fu Panda
 Power Level

This page will prompt Richard Ricardo for Kung Fu Panda Po's power level (in number). The
program will convert the given input into Po's power metric.

less than 0: Po eats too much noodle

0 to 20: Po reaches the training hall

21 to 40: Po reaches the student barracks

41 to 60: Po reaches the Peach Tree of Heavenly Wisdom
61 to 80: Po climbs the Wu Da Mountains

81 to 100: Po trains at the Pool of Sacred Tears

Greater than 100: Po defeats Tai Lung

Click on the button below to enter Po's power level.

Po's Power:
Po's power level is -15.
Po eats too much noodle.
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Example: Input q1b

Enter po's power level

Example: Output q1b

Richard Ricardo’'s Kung Fu Panda
0 Power Level

This page will prompt Richard Ricardo for Kung Fu Panda Po's power level (in number). The
program will convert the given input into Po's power metric.

less than 0: Po eats too much noodle

0 to 20: Po reaches the training hall

21 to 40: Po reaches the student barracks

41 to 60: Po reaches the Peach Tree of Heavenly Wisdom
61 to 80: Po climbs the Wu Da Mountains

81 to 100: Po trains at the Pool of Sacred Tears

Greater than 100: Po defeats Tai Lung

Click on the button below to enter Po's power level.

Po's Power:
Po's power level is 86.
Po trains at the Pool of Sacred Tears.
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Question 2 — JavaScript Chapter 3 (35 points) Estimated time: 2 hours
e Save question 2 files in subfolder “lastname_firstname_assignment4\q2\”. (-30 points if no JavaScript)
e Create a web page that displays the default information (example shown). (1 point each, total 5 points)
e The initial page and related outputs should look like the examples shown below.
e (Create your page using “<your name>’s Kung Fu Panda Po Body Mass Index” as the page title. Save the
page as index.htm. Document the html file with html & JavaScript comments. (1 point each, total 3 points)
e  Write a program that calculates and displays Kung Fu Panda Po’s body mass index (BMI). Po’s BMI is
calculated with the following formula: (5 points)
o BMI = weight x 703 / height?
o  Weight is in pounds, and height is in inches
e  The program should also indicate if Po has optimal weight, is underweight, or is overweight.
o IfPo's BMI is less than 18.5. Po is underweight
o IfPo's BMI is between 18.5 and 25. Po has optimal weight
o IfPo's BMI is greater than 25. Po is overweight (15 points for logic, 5 points for output format)
e Note: The BMI reading is not for humans. It is modified for Po. Please do not use it for humans.
Hint: You may use toFixed () JavaScript method to display a number with the exact number of
decimals.
o Create a css file named style.css to format index.htm by creating your own layout (no two students should

have the same layout). Use css comments to document the css program. (1 point each, total 2 points)

Example: Initial Page

Richard Ricardo’'s Kung Fu Panda
) Body Mass Index

page will prompt Richard Ricardo for Kung Fu Panda Po's weight and height. The
ogram will convert the given input into Po's body mass index, and will inform Richard is
Po is overweight or underweight.

BMI = weight x 703 / height?

Weight in pounds. Height in inches.

If Po's BMI is less than 18.5. Po is underweight

If Po's BMI is between 18.5 and 25. Po has optimal weight
If Po's BMI is greater than 25. Po is overweight

CIick on the button below to enter Po's weight and
height.

Enter Richard's Po weight and height

Po's BMI:
Po’'s current Body Mass Index
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Example: Input q2a

Enter po's weight
160

Enter po's height

60]

| o cancel | oK Cancel

Example: Output q2a

ichard Ricardo’'s Kung Fu Panda
) Body Mass Index

This page will prompt Richard Ricardo for Kung Fu Panda Po's weight and height. The
program will convert the given input into Po's body mass index, and will inform Richard is
Po is overweight or underweight.

BMI = weight x 703 / height?

Weight in pounds. Height in inches.

If Po's BMI is less than 18.5. Po is underweight

If Po's BMI is between 18.5 and 25. Po has optimal weight
If Po's BMI is greater than 25. Po is overweight

Click on the button below to enter Po's weight and
height.

Enter Richard's Po weight and height

Po's BMI:

Po's weight is 190 pounds.
Po's height is 60 inches.
Po's BMI is 37.10.

Po is overweight.
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Example: Input q2b

Enter po's weight: Enter po's height

160

ok | | cancel

Example: Output g2b

Richard Ricardo’'s Kung Fu Panda
) Body Mass Index

This page will prompt Richard Ricardo for Kung Fu Panda Po's weight and height. The
program will convert the given input into Po's body mass index, and will inform Richard is
Po is overweight or underweight.

BMI = weight x 703 / height?

Weight in pounds. Height in inches.

If Po's BMI is less than 18.5. Po is underweight

If Po's BMI is between 18.5 and 25. Po has optimal weight
If Po's BMI is greater than 25. Po is overweight

Click on the button below to enter Po's weight and
height.

Enter Richard's Po weight and height

Po's BMI:

Po's weight is 160 pounds.
Po's height is 68 inches.
Po's BMI is 24.33.

Po has optimal weight.
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Question 3 — JavaScript Chapter 3 (35 points) Estimated time: 3 hours
e Save question 3 files in subfolder “lastname_firstname_assignment4\q3\”. (-30 points if no JavaScript)

e Create a web page that displays the default information (example shown). (1 point each, total 3 points)

e The initial page and related outputs should look like the examples shown below.

e Create your page using “<your name>’s Employee Net Pay” as the page title. Save the page as index.htm.

Document the html file with html and JavaScript comments. (1 point each, total 3 points)
Write a program that calculated an employee’s net pay.
o The program should prompt for (1 point each, total 3 points)

* Hourly pay rate
*  Number of hours worked in a week
= Number of dependents claimed
o If the employee works more than 40 hours in a week, overtime is calculated at 1.5 times the

regular hourly rate. (10 points for logic)
o Taxes are then deducted from the gross pay as follows: (10 points for logic)
= No dependents: tax rate is 28% (5 points for output format)

= 1 to 3 dependents: tax rate is 25%

= 4 to 6 dependents: tax rate is 15%

*  More than 6 dependents: tax rate is 10%
Create a css file named style.css to format index.htm by creating your own layout (no two students should
have the same layout). Use css comments to document the css program. (1 point each, total 2 points)

ichard Ricardo’'s Employee Net

This page will prompt Richard Ricardo to calculate an employee's net pay.
Richard Ricardo will be prompted for:

* Employee's hourly rate of pay;
* Number of hours worked that week;
* Number of dependents employee has.

Click on the button below to enter Richard's employee
pay information.

Input ¢3a Output g3a and logic

Employee's hourly rate: $30. First 40 hours pay = $30 x 40 hours = $1200

Number of hours worked this week: 50 hours. Next 10 hours pay (overtime) = $30 x 10 hours x 1.5 = $450
Number of dependents: 3. Gross pay = $1200 + $450 = $1650

Tax rate for 3 dependents =25%

Tax deduction = $1650 x 25% = $412.5
Net pay = $1650 - $412.5 = §1237.5

This employee earned: $1237.5 this week.

Input ¢3b Output g3b and logic

Employee's hourly rate: $40. First 40 hours pay = $40 x 30 hours = $1200

Number of hours worked this week: 30 hours. Next 10 hours pay (overtime) = $30 x 0 hours x 1.5 = $0
Number of dependents: 4. Gross pay = $1200 + $0 = $1200

Tax rate for 4 dependents = 15%

Tax deduction = $1200 x 15% = $180
Net pay = $1200 - $180 = $1020

This employee earned: $1020 this week.
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Example: Input q3a

Enter number of hours Worked tis week.

Enter employee’s hourly rate: §

30 E

[] Prevent this page from creating additional dialogs

T

Enter number of dependents:

B
(] Prevent this page from creating addttional dialogs

Example: Output q3a

ichard Ricardo's Employee

This page will prompt Richard Ricardo to calculate an employee's net pay.
Richard Ricardo will be prompted for:
* Employee's hourly rate of pay;
of hours worked that week;
* Number of dependents employee has.

CIick on the button below to enter Richard's employee
pay information.

Employee’s hourly rate: $30.

Number of hours worked this week: 50 hours.
Number of dependents: 3.

This employee earned: $1237.5 this week.
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Example: Input q3b
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Enter number of hours worked tis week:

Enter employee’s hourly rate: §

LI

o] [owar ]

Enter number of dependents:

4

[ Preventthis page from creating additional dialogs

o] [cae

Example: Output q3b

iIchard Ricardo’'s Employee Net

This page will prompt Richard Ricardo to calculate an employee's net pay.
Richard Ricardo will be prompted for:

+* Employee's hourly rate of pay;

* Number of hours worked that week;

+» Number of dependents employee has.

CIick on the button below to enter Richard's employee
pay information.

Enter Richard's employee net pay

Employee’s hourly rate: $40.

Number of hours worked this week: 30 hours.
Number of dependents: 4.

This employee earned: $1020 this week.

o]

L] Preventthis page from creating additional dilogs

Cancel
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Important:

1. Ifyou do not put <your name> / <your first name> in the above mentioned fields (as shown in the
examples), you will get 0 points for the question(s).

2. No two students should submit webpages with exactly the same cod, or the content, or same layout, or
same color combination. If found, both students will get 0 points.

3. When you view page source in a web browser, <!DOCTYPE html> must be at the top of every page. In
other words, all pages must be written in HTMLS. (-20 points if not)

4. All html files must pass html validation at http://validator.w3.org/ without any error/warning (with only 2
warnings). Use the validator’s “File Upload” tab to check each file. (-2 points for each error/warning, 2
warnings allowed)

5. All css files must pass css validation at http://jigsaw.w3.org/css-validator/ without any error/warning. (-2
points for each error/warning)

6. If your html file contains any css component, your html file must pass both html validation (3 above), and
css validation (4 above) without any error.

7. If your files do not pass the validations, 2 points will be deducted for each error (and each JavaScript
warning) found.

8. Document (comment) your html files (<! -- -->),css files (/* */), and JavaScript files (/* */). (-1
point for each file with insufficient comments)

Submission instructions:

e  You need to test the above document(s) in your web browser.

e Do screen capture(s) of the initial page and the related output(s). Use any graphic editing software (e.g.
Microsoft Paint, Adobe Fireworks, GIMP, or Microsoft Expression Design etc) to cut out the browser
output (from the screen capture), paste them into a word document.

e For this assignment, you only need to do screen capture(s) of the initial page and the related output(s),
you do not need to do screen capture(s) of the input pages. Provide 2 different test cases for each question.
In other words, for each question, you need to have 1 initial page screen capture and 2 related output(s)
screen captures. (-50 points for no test cases, -5 points for only 1 test case)

e Do screen capture(s) of html validation results and css validation results, cut and paste them into the word
document. You do not need to do screen capture(s) of JavaScript validation results.

e Save the word document as a pdf file.

You need to submit the following:
1. A pdf file containing the screen capture(s) of the web browser output (all html pages) and the screen
capture(s) of all html validation results (from http://validator.w3.org/) and css validation results (from
http://jigsaw.w3.org/css-validator/), name the file lastname_firstname_assignment04.pdf.
2. All html file(s), css file(s), and other related files (e.g. image files). Zip your file folder
(lastname _firstname assignment4) into a single zip file (or rar file) lastname_firstname_assignment04.zip.
In the above example, the zip file should contain the following files and subfolders. If there is any image, there
should be a \images\ subfolder.

e lastname firstname assignment4\ql\index.htm
lastname_firstname_assignment4\q1\style.css
lastname_firstname assignment4\q2\index.htm
lastname_firstname_assignment4\q2\style.css // you may put style.css in a subfolder
lastname_firstname assignment4\q3\index.htm

e lastname firstname assignment4\q3\style.css
Please show the above mentioned two files: .pdf and .zip to your camp instructor.
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